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Preface

Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©June 2007

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. pat-
ents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of
this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home
or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineer-
ing or disassembly is prohibited.
Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3.5G modules, then the appropriate antennas will be installed. Note
that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in
conjunction with any other antenna or transmitter.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC 

Output of 19V, 3.42A (65 Watts) minimum AC/DC Adapter.

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, 
TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the com-
puter in a humid environment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, 

uninterrupted power supply. If you are unsure of your local power specifications, consult 
your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong 
is an important safety feature; do not defeat its purpose. If you do not have access to a 
compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by 
its wire.

• Make sure the socket and any extension cord(s) you use can support the total current load 
of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power sup-
plies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your documents are prepared.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on 
a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles 

when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent 

and short breaks are better than fewer and longer breaks.
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.
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Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, 7-in-1 card reader, ExpressCard/34/54), TouchPad & Mouse, Audio & Printer.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s Fingerprint, Bluetooth, Wireless LAN, PC Camera, TPM and 

3.5G modules (some of which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the Intel Video driver controls.
• Appendix C he computer’s specification.
• Appendix D Information on the Windows XP OS.
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in the Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page  A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the

 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Notes

Check the light colored
boxes with the mark
above to find detailed in-
formation about the com-
puter’s features. 
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Not Included
Operating Systems (e.g. Windows Vista/Windows XP) and applications (e.g. word processing, spreadsheet and
database programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed in. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed.
If your system hasn’t been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.



1 - 4 Overview

Quick Start Guide1
System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the following operating systems are sup-
ported.

Table 1 - 1 - Model Differences

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Win-
dows XP Information” on page D - 1.

Operating System & Version Note

*Windows XP (Home or Professional) In order to run Windows XP without limitations or decreased
performance, your computer requires a minimum 512MB of system

Windows Vista (64-bit) Home Basic Edition
In order to run Windows Vista without limitations or decreased
performance, your computer requires a minimum 1GB of system
memory (RAM).

Windows Vista (64-bit) Home Premium Edition

Windows Vista (64-bit)
Business/Enterprise/Ultimate Editions
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System Startup
1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
5. Raise the lid/LCD to a comfortable viewing angle, and press the power button to turn the computer “on”.
6. Adjust the LCD panel to a comfortable viewing angle.
7. The LED indicators show the power and battery status of the computer.

Figure 1 - 1 - AC/DC Adapter In

Shutdown

Note that you should always shut your computer down by choosing
the Shut Down command from the Lock Button Menu in Win-
dows Vista. This will help prevent hard disk or system problems.
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System Map: LCD Panel Open

Figure 1 - 2
LCD Panel Open

1. Built-In PC Camera 
(Optional)

2. LCD
3. Speakers
4. Power Button
5. Hot Key Buttons
6. LED Status 

Indicators
7. Keyboard
8. Touchpad & 

Buttons
9. LED Power & 

Communication 
Indicators

10. Fingerprint Module 
(Optional)

11. Built-In Microphone

2

5

1

7

8

46

9

33

11

Wireless Device 
Operation Aboard Aircraft

The use of any portable electronic
transmission devices aboard aircraft is
usually prohibited. Make sure the mod-
ule(s) are OFF if you are using the
computer aboard aircraft.

Use the key combinations to toggle
power to the 3.5G/WLAN/Bluetooth
modules, and check the LED indicator
icon to see if the modules are powered
on or not (see Table 1 - 5, on page 1 -
10/ Table 1 - 2, on page 1 - 7).

6

5
10
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LED Indicators
The two sets of LED indicators (LED Status Indica-
tors and LED Power & Communication Indicators)
on the computer display helpful information about the
current status of the computer.

Table 1 - 2 - LED Status Indicators Table 1 - 3 - LED Power & Communication Indicators

Icon Color Description

Green Silent Mode Activated (see over)

Off Normal Mode Activated (see over)

Green Hard Disk Activity

Green Number Lock Activated

Green Caps Lock Activated

Green Scroll Lock Activated (to activate 
press Fn & Scr Lk)

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking Green The Computer is in Sleep 
Mode

Orange The Battery is Charging

Green The Battery is Fully Charged

Blinking Orange The Battery Has Reached 
Critically Low Power Status

Green The (optional) Wireless LAN 
Module is Powered On

Orange The (optional) Bluetooth 
Module is Powered On

Green The (optional) 3.5G Module is 
Powered On
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Quick Start Guide1
Hot Key Buttons & Keyboard
These buttons give instant access to the default Inter-
net browser and e-mail program, and allow you to tog-
gle the Silent Mode on/off with one quick button
press.

Table 1 - 4 - Hot Key Buttons

*When enabled, Silent Mode will reduce fan noise
and save power consumption. Note this may reduce
computer performance.

The keyboard has a numerical keypad for easy numer-
ic data input, and features Function Keys to allow you
to change operational features instantly.

Activate the Number Lock feature by pressing the
Num Lk key at the top right of the keyboard. You may
check if Number Lock is enabled or not by looking at
the LED status indicators.

Hot Key Function

Activate the Default E-Mail Browser

 Activate the Default Internet Program

Toggle *Silent Mode (for power saving)

Other Keyboards

If your keyboard is damaged or you just want to make
a change, you can use any standard USB keyboard.
The system will detect and enable it automatically.
However special functions/AP-Key buttons unique to
the system’s regular keyboard may not work.
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Keyboard
The keyboard has a numerical keypad for easy numeric data input, and features func-
tion keys to allow you to change operational features instantly. See Table 1 - 5, on
page 1 - 10 for full function key combination details.

Figure 1 - 3 - Keyboard

Other Keyboards

If your keyboard is
damaged or you just
want to make a
change, you can use
any standard USB key-
board. The system will
detect and enable it
automatically. Howev-
er special functions/
hot-keys unique to the
system’s regular key-
board may not work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable num-
ber or scroll lock, and
check the LED indica-
tor for status.

Fn Key

Function Keys
NumLk & 
ScrLk Keys

Numeric 
Keypad

Numerical Keypad 

Play/Pause Key

Function Keys

Toggle Key

3.5G Module
Power 

NumLk & 
ScrLk Keys

Fn Key

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special
characters. These special characters can only be produced by using the numeric keypad.
Regular number keys (in the upper row of the keyboard) will not work. Make sure that Num-
Lk is on.
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Function/Hot Key Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed (see
“Hot Key” on page 4 - 6). When the driver is installed, an icon  will appear in the taskbar.

Table 1 - 5 - Function & Hot Key Indicators

Keys Function Keys Function

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F7 Display Toggle

Fn + _ 3.5G Module Power Toggle Fn + F8/F9 Brightness Decrease/Increase 

Fn + F1 TouchPad Toggle Fn + F10 PC Camera Power Toggle  

Fn + F2 Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on) Fn + F11 WLAN Module Power Toggle 

Fn + F3 Mute Toggle Fn + F12 Bluetooth Module Power Toggle 

Fn + F4 Sleep Toggle *Silent Mode Toggle 

Fn + F5/F6 Volume Decrease/Increase  *When enabled, Silent Mode will reduce fan noise and save power 
consumption. Note this may reduce computer performance.
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System Map: Front & Rear Views

Figure 1 - 4
Front & Rear Views

1. LCD Latches
2. LED Power & 

Communication 
Indicators

3. 7-in-1 Card Reader
4. S/PDIF-Out Jack
5. Microphone-In Jack
6. Headphone-Out 

Jack
7. Battery

2
54

1 1

63

7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / 
MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) / 

Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

7
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System Map: Left & Right Views

Figure 1 - 5
Left & Right Views

1. DC-In Jack
2. RJ-45 LAN Jack
3. External Monitor 

Port
4. Vent/Fan Intake/

Outlet
5. 3 * USB 2.0 Ports
6. Optical Device 

Drive Bay (for CD/
DVD Device - see 
page 2 - 3)

7. RJ-11 Phone Jack
8. Security Lock Slot

1 5
2

4

6 87

3 5

5

Overheating

To prevent your computer from overheating make sure nothing blocks the vent(s)/fan in-
take(s) while the computer is in use.
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Disk Eject Warning

Don’t try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don’t try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code
(see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.
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System Map: Bottom View 

Figure 1 - 6
Bottom View

1. Battery
2. Hard Disk Bay 

Cover 
(3.5G Module 
Location)

3. RAM & CPU Bay 
Cover

2

3

1

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 10 for full instructions.

CPU

The CPU is not a user serviceable
part. Opening this compartment,
or accessing the CPU in any way,
may violate your warranty.

Overheating

To prevent your computer from
overheating make sure nothing
blocks the Vent/Fan Intake while
the computer is in use.
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Windows Vista Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table , on page 4 - 3. To see all controls it may be necessary to toggle to Classic View on.

Figure 1 - 7 - Start Menu & Control Panel

Click here to toggle Classic View 
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Video Features
You can switch display devices, and configure display options, from the Display Settings control panel (in Per-
sonalization) in Windows Vista as long as the appropriate Intel video driver is installed. For more detailed vid-
eo information see “Intel Video Driver Controls” on page B - 1.

To access Display Properties in Windows Vista:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click 

Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution:  (Figure 1 - 8 on page 1 - 17).
4. Click the arrow, and scroll to the preferred setting In Colors: (Figure 1 - 8 on page 1 - 17).
5. Click Advanced Settings (button)  (Figure 1 - 8 on page 1 - 17) and click Intel(R) GMA Driver for mobile 

(tab).
6. Click Graphics Properties (button)  (Figure 1 - 8 on page 1 - 17) to access the Intel GMA control panel 

(this control panel can also be accessed by double-clicking Intel(R) GMA Driver for mobile in Classic View).
7. The Intel GMA control panel can also be accessed by clicking the icon  in the taskbar and selecting Graphics 

Properties from the menu.

Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT) or external Flat Panel Display
connected to the external monitor port as your display device.

1
2

3

4



Video Features 1 - 17

Quick Start Guide 1

Figure 1 - 8 - Display Properties Desktop

Table 1 - 6 - Display Options

Intel Display Mode Description

Single Mode One of the connected displays is used as the display device

Intel(R) Dual Display Clone Mode Both connected displays output the same view and may be configured independently

Extended Desktop Mode Both connected displays are treated as separate devices, and act as a virtual desktop

1 2

3

4
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 15) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 10.

Figure 1 - 9 - Power Options

Note: Sleep is the default power saving state in Windows Vista
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2Chapter 2: Features & Components
Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical (CD/DVD) Device
• 7-in-1 Card Reader
• ExpressCard Slot
• TouchPad and Buttons/Mouse
• Audio Features
• Adding a Printer
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2 - 2 Hard Disk Drive

2 Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other 2.5" serial (SATA) hard disk drives (see “Storage”
on page C - 3) with a height of 9.5 mm.

The hard disk is accessible from the bottom of your computer as seen below. For fur-
ther details see “Upgrading the Hard Disk Drive” on page 6 - 4.

Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure 2 - 1
Hard Disk Location
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2Optical (CD/DVD) Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the module you purchased (see “Storage” on page C - 3). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 14).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.

Sound Volume 
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting (see
“Audio Features” on
page 2 - 9).

 Figure 2 - 2
Optical Device

1

2

3

1
2

3
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2 Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
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2DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 13.
.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4 South & Central America, Mexico, 
Australia, New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding

 Figure 2 - 3
DVD Regions
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2 7-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “CardReader” on page 4 - 5).

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

 Figure 2 - 4
Right View

1. Card Reader

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS Pro (Memory Stick Pro)

• MS Duo (requires PC adapter*)
• Mini SD (requires PC adapter*)
• RS MMC (requires PC adapter*)

1
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2ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards). Make sure you install the Card Reader driver (see “CardReader” on page 4
- 5).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34.

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and push it in until it locks into place (as 

pictured in the generic figure below).
• To remove an ExpressCard, simply press the card to eject it.

ExpressCard 
Slot Cover

Make sure you keep the
rubber cover provided in
the ExpressCard slot
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the Express-
Card Slot.

 Figure 2 - 5
Left View

1. Express Card 
Slot

 Figure 2 - 6
Inserting & 

Removing Express 
Cards

1
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2 TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse. 

Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 5) you
can configure the functions by double-clicking the TouchPad driver icon  on the
taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer
motion and sensitivity options to your preferences. You will find further information
at www.synaptics.com.

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

 Figure 2 - 7
Mouse Properties
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2Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the taskbar/
control panel (right-click the taskbar icon  to bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination. 

Sound Volume 
Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 8
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.
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2 Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows
Vista OS.)
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 14).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 10.
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-
key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down). Use Power Op-
tions (Hardware and Sound menu) control panel in Windows Vista to configure
this feature.

Shut Down

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the Lock Button
Menu in Windows Vis-
ta. This will help prevent
hard disk or system
problems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow-
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Buttons” on page 3 - 8 for details).
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

Resuming 
Operation

See Table 3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan 

Advanced Settings
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 2
Power Plans
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Sleep is the default power-saving state in Windows Vista.

Earlier versions of Windows used Stand By and Hibernate as system power-saving
states. Windows Vista combines the features of Stand By and Hibernate into the de-
fault Sleep power-saving state.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

Power Button

The Power Button 
in the Start Menu (in
Classic View use the
Shut Down button )
can be used to send the
computer into a power-
saving state.

Sleep Mode & 
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power. 

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut Down
You should shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from shut down takes longer than
from Sleep or Hibernate.

Silent Mode

You can use Silent
Mode to reduce power
consumption and fan
noise.

Use the Silent Mode
hot key  to toggle this
mode on/off. 

On screen visual indica-
tors and the LED indica-
tor  will display the
Silent Mode status (see
Table 1 - 3, on page 1 -
7 and Table 1 - 5, on
page 1 - 10).

Note Silent Mode may
reduce computer perfor-
mance.

Figure 3 - 3
Lock Button menu
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state.Password 

Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table 3 - 1
Resuming 
Operation

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon  in the taskbar to see the current battery level and charge
status.

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 5
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.

Windows Mobility 
Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power
plans used and wireless
device status etc.

Figure 3 - 6
Windows Mobility 

Center
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “- LED Status
Indicators” on page 1 - 7 for information on the battery charge status, and to “Bat-
tery Information” on page 3 - 10 for more information on how to maintain and
properly recharge the battery pack.)
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power 

settings.

Figure 3 - 7
Power Plan Create
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 8
Power Options 

Advanced Settings - 
Battery
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities. 

What to Install
The Device Drivers & Utilities + User’s Manual CD-
ROM (Win Vista) contains the drivers and utilities
necessary for the proper operation of the computer. 

Table , on page 4 - 3 lists what you need to install and
it is very important that the drivers are installed in
the order indicated (see “Driver Installation” on
page D - 27 for Windows XP information).

Module Driver Installation
The procedures for installing drivers for the Finger-
print, Bluetooth, Wireless LAN, PC Camera, TPM
and 3.5G modules are provided in “Modules & Op-
tions” on page 7 - 1.
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
CD-ROM and click Install Drivers (button).

If you wish to install the drivers manually see overleaf
for the driver path information.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table , on 
page 4 - 3 (the drivers must be installed in this 
order) which is the same as that listed in the Driv-
ers Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become grayed out (if 
you need to reinstall any driver, click the Unlock 
button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

 
Figure 4 - 2 - Drivers Installer Screen 2
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Table 4 - 1- Driver Installation and Location

Driver Page Driver Location Note

Video Page 4 - 5 Vista 64bit: X:\Drivers\Video\vista64\Setup.exe Manual Driver 
Installation
If you wish to install the 
drivers manually, click 
the Exit button to quit 
the Drivers Installer 
application, and then 
browse to the 
executable file in the 
location listed in this 
table and follow the 
installation procedure 
for each driver. Note 
that X is the drive 
letter assigned to the 
CD/DVD-ROM drive.

Audio Page 4 - 5 Vista 64bit: X:\Drivers\Audio\Setup.exe

Modem Page 4 - 5 Vista 64bit: X:\Drivers\Modem\ssetup.exe

LAN Page 4 - 5 Vista 64bit: X:\Drivers\Lan\setup.exe

TouchPad Page 4 - 5 Vista 64bit: X:\Drivers\TouchPad\Setup.exe

CardReader Page 4 - 5 Vista 64bit: X:\Drivers\CardReader\Setup.exe

Fingerprint Reader Page 7 - 3 Vista 64bit: X:\Drivers\FingerPrint\Application\x64\autorun.exe

Hot Key Page 4 - 6 Vista 64bit: X:\Drivers\Hotkey\Setup.exe

Bluetooth Module Page 7 - 7 Vista 64bit: X:\Drivers\Option\Bluetooth\setup.exe

Wireless LAN Module Page 7 - 11 Vista 64bit: X:\Drivers\Option\WLAN\Intel\Autorun.exe (for Intel WLAN)

PC Camera Module Page 7 - 17 Vista 64bit: X:\Drivers\Option\Camera\Sertek\setup.exe (for 1.3M pixel Camera)
Vista 64bit: X:\Drivers\Option\Camera\Dmax\Setup.exe (for 2.0M pixel Camera)

Trusted Platform Module Page 7 - 27 Vista 64bit: X:\Drivers\Option\TPM\setup.exe

3.5G Module Page 7 - 40 Vista 64bit: X:\Others\04_3G\3G.msi
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue the in-
stallation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installa-
tion procedure (other than when outlined in the
driver install procedure), click Cancel to close the
window, and follow the installation procedure.
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Driver Installation Procedure

Video
1. Click 1.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Audio
1. Click 2.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

Modem
1. Click 3.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.

LAN
1. Click 4.Install Lan Driver > Yes. 
2. Click Next > Install.
3. Click Finish.
4. The network settings can mow be configured.

TouchPad
1. Click 5.Install Touchpad Driver > Yes.
2. Click Next.
3. Click Finish > Restart Now to restart the com-

puter.
4. You may then configure your TouchPad as out-

lined in “TouchPad and Buttons/Mouse” on 
page 2 - 8.

CardReader
1. Click 6.Install Cardreader Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Modem Country Selection

Go to the Phone and Modem Options control panel (Hard-
ware and Sound) and make sure the modem country selection
is appropriate for you.
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Fingerprint Reader Module
See the introduction in “Fingerprint Reader Module”
on page 7 - 3, and check the installation procedure.

Hot Key
1. Click 7.Install Hotkey Driver > Yes. 
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.

Bluetooth Module
See the introduction in “Bluetooth Module” on
page 7 - 7, and check the installation procedure.

Wireless LAN Module
See the introduction in “Wireless LAN Module” on
page 7 - 11, and check the installation procedure.

PC Camera Module
See the introduction in “PC Camera Module” on
page 7 - 16, and check the installation procedure.

Trusted Platform Module
See the introduction in “Trusted Platform Module”
on page 7 - 25, and check the installation procedure.

3.5G Module
See the introduction in “3.5G Module” on page 7 - 37,
and check the installation procedure.
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
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The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
you disable the Boot-
time Diagnostic Screen,
the POST screen will not
appear.

Figure 5 - 1
POST Screen

Phoenix TrustedCore(tm) NB
Copyright 1985-2006 Phoenix Technologies Ltd.
All Rights Reserved
Bios Revision: ********
KBC/EC Firmware Revision: ********

CPU = 1 Processors Detected, Cores per Processor = 2
Intel(R) Core(TM)2 Duo CPU T7500 @ 2.20GHz
1015M System RAM Passed
4096 KB L2 Cache
System BIOS shadowed
Video BIOS shadowed
Fixed Disk 0: FUJITSU MHW2060BH
ATAPI CD-ROM: Optiarc CD-RW CRX880A
Mouse intialized

Press <F2> to enter SETUP

1

2
3

4
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup 

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.
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The Setup Program
The Phoenix Setup program tells the system how to configure itself and manage ba-
sic features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screen to
make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.



BIOS Utilities

5 - 6 Main Menu

5

Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

<Tab>, <Shift Tab>, or
<Enter> selects field.

Main

BIOS Revision ********

System Time: [22:12:05]
System Date: [06/12/2007]

� IDE Primary/Master [FUJITSU MHW2060BH-(S1)]
� IDE Secondary/Master [Optiarc CD-RW CRX880A-(SM]

System Memory 640 KB
Extended Memory 1038336 KB

Phoenix TrustedCore(tm) Setup Utility
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IDE Primary/Master (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a HDD on the com-
puter’s IDE Primary/Master Channel. Use the Auto (Type:) setting to have the items
configured automatically for you.

IDE Secondary/Master (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of an optical Device
on the computer’s IDE Channel 1. Use the Auto (Type:) setting to have the items
configured automatically for you.

System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.
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Advanced Menu

Reset Configuration Data: (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have in-
stalled a new add-on which has reconfigured the system, resulting in such a serious
system conflict that the operating system is unable to boot.

Figure 5 - 3
Advanced Menu Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Select 'Yes' if you
want to clear the
Extended System
Configuration
Data (ESCD) area.

Phoenix TrustedCore(tm) Setup Utility

�Reset Configuration Data: [No]
Local Bus IDE adapter: [Both]

Boot-time Diagnostic Screen: [Enabled]
Legacy USB Support: [Enabled]
USB 2.0 Enable: [Enabled]
POST Beep Sound [Disabled]

Total Graphics Memory: [128MB]
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Local Bus IDE adapter: (Advanced Menu)
This item allows you to configure the IDE bus which controls the hard disk and op-
tical devices. It is set to “Both” by default.

Boot-time Diagnostic Screen: (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen.

Legacy USB Support: (Advanced Menu)
Use this menu item to enable/disable the support for Legacy Universal Serial Bus.

USB 2.0 Enable:
This menu item can be used to enable/disable support for USB 2.0.

POST Beep Sound (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Total Graphics Memory: (Advanced Menu)
Use this menu item to set the amount of system memory to be allocated for use by
the internal graphics device. The default memory size allocated is 128MB, and this
may be adjusted to 256MB (by pressing the spacebar to adjust) if required.
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Phoenix TrustedCore Setup Utility. This
will not affect access to the computer OS, (only the Phoenix TrustedCore Setup
Utility).

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure 5 - 4
Security Menu

Main Advanced SSeeccuurriittyy Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Enable Trusted Platform
Module support

Security

Supervisor Password Is: Clear

Set Supervisor Password [Enter]
Password on boot: [Disabled]
Fixed disk boot sector: [Normal]

TPM Support [Disabled]

Phoenix TrustedCore(tm) Setup Utility
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Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”. 

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Fixed disk boot sector: (Security Menu)
If you choose “Write-Protect” this will protect against viruses being written to the
hard disk boot sector (this is not a substitute for installing an anti-virus program - see
“Viruses” on page 8 - 4).

TPM Support (Security Menu)
Enable TPM Support from this menu, and the TPM State menu will then appear
(see “TPM State” on page 5 - 12). Note: If you disable TPM Support then your
TPM information may be erased altogether. You should only disable TPM support
when you need to clear the TPM information. The default setting is “Disabled”. 

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.

TPM Password

Note that you should set
a supervisor password
in the BIOS to protect
the TPM information
from being tampered
with by unauthorized us-
ers.



BIOS Utilities

5 - 12 TPM State

5

TPM State

Change TPM State (TPM State)
This menu allows you to set the level of TPM functionality. You can enable/disable
the TPM function altogether, or clear all existing TPM information. 

Note: If you clear all TPM information it will be erased altogether and the informa-
tion will need to be reconfigured.

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Changes TPM State

TPM State

Current TPM State: Enabled and Deactivated

Change TPM State [No Change ]

No Change
Enable & Activate
Deactivate & Disable
Clear

Phoenix TrustedCore(tm) Setup Utility
TPM State Menu

To access this menu
you must first enable
TPM support from the
security menu (see
page 5 - 11).

Password 
Protection

Note that you should set
a supervisor password
in the BIOS to protect
the TPM information
from being tampered
with by unauthorized us-
ers.

Figure 5 - 5
TPM State
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If you have made any changes to the TPM State you will be asked to execute or reject
the changes made after you have saved and exited the BIOS. Highlight the required
option (it will be white), and then press Enter to save it.

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Physical Presence operations

TPM configuration change was requested to
State: Clear

WARNING!!!
Clearing erases information stored on the TPM.
You will lose all created keys and access to
data encrypted by these keys. to

Reject
Execute

Phoenix TrustedCore(tm) Setup Utility

Execute Physical
Presence operations
and exit

Figure 5 - 6
Physical Presence 

Operations
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
Vista) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.

Figure 5 - 7
Boot Menu

Phoenix TrustedCore(tm) Setup Utility

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or
configure devices:
Up and Down arrows
select a device.
<+> and <-> moves
the device up or down.
<x> exclude or include
the device to boot.

Boot priority order:
1: USB FDC:
2: IDE CD: Optiarc CD-RW CRX880A-(SM)
3: IDE HDD: FUJITSU MHW2060BH PL-(S1)
4: USB HDD:
5: PCI BEV: Realtek Boot Agent
6:
7:
8:

Excluded from boot order:
: USB KEY:
: USB CDROM:
: USB ZIP:
: 1394 CDROM:

Main Advanced Security Boot Exit
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 8
Exit Menu

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Exit System Setup and
save your changes to
CMOS.

Exit Saving Changes
Exit Discarding Changes
Load Setup Defaults
Discard Changes
Save Changes

Main Advanced Security Boot Exit
Phoenix TrustedCore(tm) Setup Utility
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Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive
• Upgrading the Optical (CD/DVD) Device
• Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.



Upgrading The Computer

Removing the Battery 6 - 3

6

Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.
1. Turn the computer off, and turn it over.
2. Slide the latch  in the direction of the arrow.
3. Slide the latch  in the direction of the arrow, and hold it in place.
4. Slide the battery out in the direction of the arrow .

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal

1
2

3

2

3

1
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Upgrading the Hard Disk Drive
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
disk drives with a height of 9.5mm (h) (see “Storage” on page C - 3). Follow your
operating system’s installation instructions, and install all necessary drivers and util-
ities (see “Driver Installation” on page 4 - 2), when setting up a new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and loosen screws  & .
3. Remove the hard disk bay cover .
4. Grip the tab and slide the hard disk in the direction of arrow .

HDD System 
Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 2
Hard Disk Bay & 

Screws
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5. Lift the hard disk up in the direction of arrow .
6. Remove the screws  &  and cover .
7. Reverse the process to install a new hard disk drive.

Figure 6 - 3
HDD & Cover 

Removal

5
6 7 8
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Upgrading the Optical (CD/DVD) Device
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the RAM & CPU bay cover and remove screws  - .
3. Remove the screw at point , and use a screwdriver to carefully push out the 

optical device at point .
4. Reverse the process to install the new device.

Figure 6 - 4
Removing the CD/

DVD Device
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-
DIMM) DDRII (DDR2) type memory modules (see “Memory” on page C - 2 for
details of supported module types). 

The total memory size is automatically detected by the POST routine once you turn
on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the RAM & CPU bay cover and remove screws  - .1 4

3

4

21

Figure 6 - 5
RAM & CPU 
Bay Screws
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3. Carefully (a fan and cable are attached to the under side of the cover) lift up the 
bay cover.

4. Carefully disconnect the fan cable , and remove the cover .

5. Gently pull the two release latches on the sides of the memory socket in the 
direction indicated by the arrows (  & ) in Figure 6 - 7.

5 6

5

6

7 8

Figure 6 - 6
CPU/RAM Bay 

Cover Removed

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure 6 - 7
RAM Module 

Release Latches

7

8
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6. The RAM module will  pop-up, and you can remove it.

7. Pull the latches to release the second module if necessary.
8. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory slot.
9. The module’s pin alignment will allow it to only fit one way. Make sure the module 

is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit 
without much pressure.

10. Press the module in and down towards the mainboard until the slot levers click into 
place to secure the module.

11. Replace the bay cover and screws (make sure you reconnect the fan cable 
before screwing down the bay cover - see Figure 6 - 6 on page 6 - 8).

12. Restart the computer to allow the BIOS to register the new memory configuration 
as it starts up.

9

Figure 6 - 8
RAM Module 

Removal

9
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Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

Warranty

The CPU is not a user
serviceable part. Open-
ing this compartment, or
accessing the CPU in
any way, may violate
your warranty.

Unauthorized tampering
with the HDD may also
violate your warranty.
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Chapter 7: Modules & Options
Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

• Fingerprint Reader Module
• Bluetooth Module
• Wireless LAN Module
• PC Camera Module
• Trusted Platform Module
• 3.5G Module

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft. 

Important Notice

If your purchase option includes both Wireless LAN and 3.5G modules, then the appropri-
ate antennas will be installed. Note that In order to comply with FCC RF exposure compli-
ance requirements, the antenna must not be co-located or operate in conjunction with any
other antenna or transmitter.
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Security Modules (Fingerprint & TPM)
The encrypted channel between the Trusted Platform Module security chip and
the optional fingerprint reader with Protector Suite Software provides a high
level of security for your computer. A further level of security and control is provid-
ed in the BIOS (see “Security Menu” on page 5 - 10).

The fingerprint reader and Protector Suite Software allow you to:
• Access or Lock your computer
• Protect sensitive files
• Display and file your favorite web pages
• Fill in frequently used dialogs
• Run your favorite applications

The TPM security chip allows you to create and manage digital certificates for user
and platform authentication. This type of security is usually administered within
large enterprises and organizations, and therefore requires implementation by a sys-
tem administrator before users can access security features.

Individual users can use the TPM as an authentication with the fingerprint reader.

See overleaf for information installing and configuring the Protector Suite Soft-
ware, and see “Trusted Platform Module” on page 7 - 25 for information on TPM.

Password Warning

If you set passwords for
any of the security mod-
ules, NEVER forget your
password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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Fingerprint Reader Module
If you have included the fingerprint reader in your purchase option you will need to
install the driver as per the instructions below. 

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs >
Protector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual CD-ROM (Win 

Vista) into the CD/DVD drive.
2. Click Install Vista Drivers (button).
3. Click 7.Install Fingerprint Driver > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.

Help & Manual

Right-click the taskbar icon
 to bring up the menu to

select Help.

Insert the Device Drivers &
Utilities + User’s Manual
CD-ROM and click Install
Vista Drivers (button).
Click Unlock (button) and
then click 7.Install Finger-
print Driver > Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual CD-ROM and click
User’s Manual (button),
and click Install Acrobat
Reader (button).
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User Enrollment
1. Click Start > Programs/All Programs > Protector Suite QL > User Enrollment, 

or double click the taskbar icon .
2. On the first run of the program you will be asked to click the button to accept the 

license, and then click OK.
3. Click Next and select “Enrollment to the hard disk”, and click Finish.

4. If you have not set a Windows password you will be prompted to do so (note: If 
you have not set a password Protector Suite QL cannot secure access to your 
computer).

5. Click Next.
6. You will then be prompted to enter your Windows password.
7. Click Next > Next (if you have the “Run interactive tutorial” tickbox selected you 

will run through the Fingerprint Tutorial).
8. Click Next for each window of the tutorial (you can click the button to “skip 

tutorial” at any time).

Figure 7 - 1
Enroll to Hard Disk
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9. Click the button above any of the fingers to begin the enrollment process for that 
finger.

10. Swipe the finger three times to enroll that finger.
11. Repeat the process for all the fingers you wish to enroll (see sidebar), and then 

click Next.
12. Click Finish.
13. Click any of the headings under “Learn more about:” to get more information on 

any topic.
14. Click Close.

15. Restart the computer.
16. Right-click the taskbar icon  to bring up the menu that allows you to Edit 

Fingerprints, Start Control Center, access the Help menu etc. You can also run 

Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 2
Fingerprint 
Enrollment
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the Control Center etc. from the Protector Suite QL item in the Programs/All 
Programs menu.

17. See “Help & Manual” on page 7 - 3 for further details.
18. If you swipe your finger over the reader at any time you can access the Biomenu 

to lock the computer, register websites, open the Control Center and access 
the Help menu.

19. The Control Center allows you to change the Settings, enroll Fingerprints and 
get Help.

Figure 7 - 3
Control Center & 

Biomenu 
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Bluetooth Module
Before installing the Bluetooth driver, make sure that the optional Bluetooth mod-
ule is on. Use the Fn + F12 key combination (see “Function/Hot Key Indicators”
on page 1 - 10) to toggle power to the Bluetooth module. Make sure you install
the drivers in the order indicated in Table , on page 4 - 3.

Bluetooth Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual CD-ROM (Win 

Vista) into the CD/DVD drive.
2. Click Install Option Drivers (button).
3. Click 1.Install Bluetooth Driver > Yes.
4. Choose the language you prefer, and click OK > Next.
5. Click the button to accept the license agreement, and then click Next.
6. Click Next > Install.
7. Click Finish, and the BlueSoleil icon  will appear on the desktop.
8. You can configure the settings at any time by going to the IVT Corpora-

tion BlueSoleil - Main Window (Start > Programs/All Programs > IVT 
BlueSoleil > BlueSoleil), or by clicking the desktop icon .

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 5, on
page 1 - 10/ Table 1 - 3, on
page 1 - 7).
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User Guides & Help

View the BlueSoleil
User Guides from the
Help Menu (or press the
F1 key) in the IVT Cor-
poration BlueSoleil -
Main Window control
panel. 

Click the Help menu
and select Contents
and Index. 

Look through Getting
Started or select the ap-
propriate User Guide
from the Contents
menu.

Figure 7 - 4
BlueSoleil Main 
Window & Help
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Bluetooth Local Area Connection
You can check the Bluetooth connection status from the Network and Sharing
Center:

1. Use the Fn + F12 key combination to turn on the Bluetooth module.
2. Run the IVT Corporation BlueSoleil program from the desktop icon or Start menu.
3. Click Start, and click Control Panel (or point to Settings and click Control Panel).
4. Double-click Network and Sharing Center (Network and Internet).
5. Click Manage network connections.
6. The Bluetooth connection status will then be displayed in the control panel.

7. To disconnect click File from the IVT Corporation BlueSoleil - Main Window, 
and select Exit (the Local Area Connection will then display “Network cable 
unplugged”).

Disconnecting

In order to have the Local
Area Connection icon dis-
play the correct connection
status, you will need to exit
the IVT Corporation Blue-
Soleil - Main Window by
clicking the File menu and
selecting Exit (see over).

After exiting the program
you can then use the Fn +
F12 key combination to
turn off the Bluetooth mod-
ule.

If you use the close button,
or turn off the Bluetooth
module (by using the Fn +
F12) the icon will not dis-
play the correct status 

Figure 7 - 5
Local Area 
Connection
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8. Do not use the close  button or Fn + F12 key combination before clicking File >
Exit or the correct status will not be displayed.

9. You can then use the Fn + F12 key combination to turn off the Bluetooth module
(check the LED icon for the Bluetooth module power status).

Figure 7 - 6
Bluetooth 

Disconnected
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Wireless LAN Module
If you have included an Intel PRO/Wireless 3945ABG (802.11a/b/g) or Intel PRO/
Wireless 4965ABN (802.11a/g/n) PCIe WLAN module in your purchase option,
make sure that the Wireless LAN module is on before installing the driver. 

Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1
- 10) to toggle power to the Wireless LAN module. Make sure you install the drivers
in the order indicated in Table 4 - 1, on page 4 - 3.

Intel WLAN Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual CD-ROM (Win 

Vista) into the CD/DVD drive.
2. Click Install Option Drivers (button).
3. Click 2.Install WLAN Driver > Yes.
4. Click Install Software.
5. Click the button to accept the license and click Next.
6. Click Next > OK.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows Vista (see overleaf).

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 5, on
page 1 - 10/ Table 1 - 3, on
page 1 - 7).
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Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect to a network (or right-
click the icon , and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.
3. A list of currently available networks will appear.

Figure 7 - 7
Taskbar Menus

Network and 
Sharing Center

You can also use the
Network and Sharing
Center control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 8
Connect to a 

Network

Click icon Right-click icon
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4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click Set up a connection or 

network (a list of options will appear allowing manual searching, and creating a 
new network).

6. Move the cursor over the taskbar icon  to see the connection status (see below).

Figure 7 - 9
Connecting

Figure 7 - 10
Connection Status
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7. To disconnect from the wireless network you can click the taskbar wireless icon , 
and then select Connect or disconnect to access the network menu, and click 
Disconnect (or right-click the icon , and then click Disconnect from).

Security Enabled 
Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unautho-
rized access to your
computer, documents, web-
sites and files etc.

Figure 7 - 11
Disconnecting

Click icon

Right-click icon
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or point to Settings and click Control 

Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.

Figure 7 - 12
Windows Mobility 

Center
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PC Camera Module
There are 2 camera options available for this computer, depending on your purchase
configuration. The 1.3M pixel camera module uses the BisonCap application, and
the 2.0M pixel camera module uses the Video View application, to capture video
files.

Before installing the PC Camera driver, make sure that the optional PC Camera is
on. Use the Fn + F10 key combination (see Table 1 - 5, on page 1 - 10) to toggle
power to the PC Camera module. Make sure you install the drivers in the order
indicated in Table , on page 4 - 3.

Latest PC Camera 
Driver Information

Check the CD, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here.
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PC Camera Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual CD-ROM (Win 

Vista) into the CD/DVD drive.
2. Click Install Option Drivers (button).
3. Click 3.Install Camera Driver > Yes.
For the 1.3M Pixel Camera Module:
1. Choose the language you prefer and click OK > Next > Next.
2. Click Finish to restart the computer.
3. Run the BisonCap application program from the BisonCam shortcut on the 

desktop, or from the BisonCam item in the Start > Programs/All Pro-
grams menu (if the hardware is turned off use the Fn + F10 key combina-
tion to turn it on again).

For the 2.0M Pixel Camera Module:
1. Click Install.
2. Click to select Yes or No in answer to the power system question.
3. Click to select Yes or No to enable/disable the Digital Zoom function.
4. Click Finish > Finish to restart the computer.
5. Run the Video View application program from the Video View shortcut on 

the desktop, or from the USB2.0 PC Camera item in the Start > Pro-
grams/All Programs menu (if the hardware is turned off use the Fn + F10 
key combination to turn it on again).
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PC Camera Audio Setup (all camera modules)
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control 
Panel).

2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is 

not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
7. Click OK and close the control panels.
8. Run the BisonCap application program from the Start > Programs/All Programs 

> BisonCam menu.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should 

have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick 

alongside it).




